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File Extensions
.MTH
.RUN
.XMS
.SMP
.SEQ
.RCL
.MLG
.MSR
.IQD
.IRL
.IRM
.IRO
.MSF
.CDF
.MSP
.TXT

Method
GC Detector Data
MS Data
Sample List
Sequence List
Recalculate List
Message Log
Report File
Dash Queries
Dash RuleList
Dash Report Template
Dash Method Objects
AMDIS Data File
Content Definition File
Spectrum List
Text File

Routine operations with Scion MS Workstation are quite easy to set up parameters
for data collection and report generation . The following is a discussion of hidden quirks
that may not be obvious as to their usefulness. This discussion assumes that the operator
is familiar with basic operations in MS Workstation.

Operations Involving Control of Scion 436/456 Gas Chromatographs.
1. System Control should be closed before powering off the GC, to maintain
interconnection between instrument and MS Workstation. Reconnection becomes
automatic. If needed, the reconnection can be established by viewing video at
http://lotusinstruments.com/reconnecting-a-456436-in-ms-workstation-8/.
2. Full access to methods through instrument display, even active one, during data
collection.

3. GC Remote Control - allows view of status of
gas chromatograph from a remote computer,
typically through Team Viewer or similar app.
(C:\Program Files\Scion GC Tools\GC
Remote Control). Access is
through Taskbar icon:

4. Reboot gas chromatographs through
GC Remote Control by setting a minor
change to System Time through Setup >
System.

5. Change
time/value
for
any
timeprogrammable parameter while running, if the
step has yet to be executed
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6. Instrument Log – lists activities for the
instrument, including faults with time/date
stamp.
Historical logs are available at
C:\ScionWS\MSLOG.

7. Runlog - documents all actual run conditions on GC in every
.RUN file for full recovery at a later time, even changes made
during the run.

8. Access any method – even if it does not match current Setup.
9. Automatic update of method when
hardware is added/deleted in Setup. All other
hardware and calculations remain intact.

10. Resume Plot - permits visible
display of active baseline drift
and noise without starting a run.
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11. FID/NPD/PDD Detector Full Scale - the
electrometer for these three detector types
has the ability to auto-range over the full
range of the detector. To activate this feature,
full scale parameter is set to 1000 V.

12. Entry and display of temperature
zones in 0.1 oC increments.

13. Stability of temperature zones temperature variation over 10
minutes for Electron Capture
Detector. Average is 250.015 ±
0.006 oC.

14. Data Rates for GC Detectors – All detectors,
including Electron Capture Detector (ECD),
have full range of data rates, from1 Hz to 600
Hz, in 12 steps.

15. Ready “Green”/Not Ready “Red”
status lights.
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Common Hints for Both MS and GC Detector Operations

16. Concurrent instrument control and data collection for MS and
GC with single Method.

17. Concurrent data collection for MS and GC with single
SampleList.

18. GC chromatogram can be
displayed in MS Data Review, by
right-clicking on .RUN file in
Windows Explorer.
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19. Compute GC Detector
Peak-to-Peak Noise in
MS Data Review. Use
mouse to draw line for
noise calculation.

20. Compute GC Detector Root Mean
Square Noise in MS Data Review.
Open .RUN file in MSWS and use
mouse to draw line for noise
calculation.

21. Up to 50 calibration levels.
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22. Calibration plots of response
factor
versus
log[concentration] - from Lotus
Consulting. Conventional plots
of detector response versus
concentration does not provide
good visibility of linearity over
wide concentration ranges.
Results displayed as a semilog
plots allows easy validation of linearity over wide concentration ranges. Routine available
from Lotus Consulting.

, as specified in most EPA methods.1

23. Response factors computed as

24. Recalc List – This screen allows selected data files to be recalculated with a modified or
different method. The list can be generated automatically by entries in SampleList.

25. Drag/drop data files into Recalc list.

1

US EPA, Compendium Method TO-15 Determination of Volatile Organic Compounds (VOCs) In Air Collected In
Specially-Prepared Canisters and Analyzed by Gas Chromatography/Mass Spectrometry (GC/MS), 1999,
https://www3.epa.gov/ttnamti1/files/ambient/airtox/to-15r.pdf, p. 15-23.
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26. Calculation of Retention Time - MS Workstation establishes retention time of a peak by
computing the zero crossover of the first derivative of the peak. It this value does not
correspond to a collected data point, precise timing is determined by linear interpolation
of points before and after the zero crossing.

27. Retention Time reported in 0.001
minute increments.

mVol

3.361 minutes

80

3.821 minutes

28. Peak Width at ½ height reported in
seconds.

29. Start and end points for peak integration are always on
the chromatogram tracing.

0
3.0

4.0 Minute
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30. Sequence List – This
screen permits multiple
actions related to using a
series of methods with
multiple SampleLists or
RecalcLists. The related
MessageLog can be printed
to provide documentation of
actions.

31. Notes - Free-form user commentary on various activities:



Method Notes.

Injection Notes.





Sample List Notes.
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Sequence List Notes.



Recalc List Notes.

32. Batch Processing - icon accessible at Start > MS Workstation > Batch Reporting. Easy
and quick approach to reprocess lots of similar data files by highlighting desired data files
in Windows Explorer and drag-drop into window.

33. Sample injection time/date
and sample name are locked
at time of data collection and
cannot be changed postrun.

Title :
Run File : c:\users\lotus\desktop\2020-07-31 14-57-42 test inj 1 - calibration 07-272020.run
Method File : C:\ScionWS\methods\Calibration 07-27-2020.mth
Sample ID : Test
Injection Date: 7/31/2020 2:57 PM Calculation Date: 7/31/2020 3:10 PM
Operator : Detector Type: 4XX-GC (10 Volts)
Workstation: Windows Bus Address : 44
Instrument : Canby Sample Rate : 1.00 Hz
Channel : Middle = TCD Run Time : 13.000 min
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34. Name of Operator can be entered when
a SampleList of Sequence is initiated and
cannot be changed postrun.

35. Automatic recalculation of
data files with Sequence
list with different method
immediately following data
collection, with no operator
interactions, using Recalc file
created with .SMP actions.

36. MessageLog lists all system
control activities, documented
with time/date of injection, sample
labeling, data file label and
location, and errors. These logs
are available for recall later.

37. Echo - This AutoLink application
inserts a string in the Message
Log. Use the following syntax in
the AutoLink field in a
SampleList or RecalcList:
command-line: echo
other-parameters: <descriptive
text to be "echoed" in the
Message Log>
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38. Header block in System Control:









Listing of active method
Active automation file
Last data file collected
Active sample name
Injection counter
Number of calculated files
Button to reactivate active method

39. Live display of all valve activities on System Control
screen.

40. Stream Selector Valve Controller – from Lotus
Consulting. Control of sampling position for
loading gas samples is set through SampleList.
Access is with Task Bar icon:

41. Direct access to SampleList from 8400
display by clicking on center of carousel.
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42. Direct access to Inject Single
Sample by clicking on vial position
in 8400 display.

43. Run Counter - available from Lotus Consulting. It is designed to complement MS
Workstation, adding the ability to track the
maintenance lifetime of one or more components.
Run Counters increments a cycle counter for
designated components each sample run,
providing a message log entry and on-screen alert
when the configured lifetime has
been reached.
Additionally,
counter details can be reviewed
including percentage of useful
lifetime and predicted end-of-life

44. Graphic display of
calibration plot for
GC detectors by
Method Editor >
Calibration Setup >
View Curves for GC
detectors.
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45. Graphic display of calibration plot for MS
data through Method Editor > Channel 1=MS
Data > MS Data Handling > Compound Table
> View Curves.

46. Edit out
points in
clicking
Excluded
red.

47. Interconversion of detector response and
concentration per calibration curve. This
calculator allows anticipation of expected peak
size for a given peak size.
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obviously invalid data
calibration plot by right
on
specific
points.
points are indicated in

48. Source of calibration data point
with Calibration Curve > Point Info.

49. Edit/Lock Coefficients - When multiple
standards with differing analytes are used,
coefficients need to be locked after they are
calibrated so that the next mixture does not
alter them. In addition, coefficients from
related analytes can be manually entered. For
example, the response values for propane
with a flame ionization detector can be
applied to other hydrocarbons.
50. Approaches to opening method:



Task Pane



Windows Explorer
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Method Builder icon on Task Bar.

51. Indication that Method file has not been saved with
an asterisk after the file name in the header. If not
manually saved, a prompt will appear for saving.

52. Activate method through
SampleList.

53. Activate “Last Edited” method.
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54. View multiple methods
side-by-side
on
one
screen.

55. Sep Codes - indicated in reports.

SepCodes

Peak Onset

Peak
End

BB

Baseline

Baseline

BV

Baseline

Valley

VV

Valley

Valley

VB

Valley

Baseline

TF

Tangent Fused

TS

Tangent Skim
Perpendicular
Baseline
Drop
Perpendicular
Baseline
Drop
Perpendicular
Baseline
Drop
Perpendicular
Valley
Drop
Perpendicular
Valley
Drop
Grouped Peaks by Time

PB
BP
PB
VP
PV
GR
HF

Horizontal Baseline Forward

HB

Horizontal Baseline Backwards

56. Tangent Percent for fused peaks - This compares the height of the rider peak to the
height of the mother. If the ratio exceeds the Tangent Percent value, a perpendicular
drop is executed, and peak is reported as “Valley/Baseline - VB”. If less than this value,
a skim is undertaken and marked as “Tangent Skim - TS”.
Perpendicular drop to
baseline at valley point

Tangent skim
of rider peak

Mother
Peak

16

Rider
Peak

57. Export SampleList to Excel

58. Import SampleList from Excel.

59. Set Default Entries simplifies construction of
SampleList.

60. Copy/paste lines in SampleList with “Shift – c” and then “Shift - v”.

61. Copy/paste lines in RecalcList with “Shift – c” and then “Shift - v”.
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62. Move columns in SampleList
by right-clicking in header.

63. Relabel column header in
SampleList.

64. Security – Passwords,
Application Lock and File
Revision Settings. Details
displayed with “Help”.
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65. Recent Files button - This
action significantly reduces
errors in entry of file name and
directory path.

66. Enable Automated Printing – must be checked for
proper printing after each run.

67. Specify/Create data file folder from SampleList.
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68. Status/Error Codes
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69. SampleList AutoLink commands:
 WAIT - This AutoLink application pauses for a specified time before terminating; it can
be used to perform injections on a specific timetable, for example, start up the GC
early in the morning and run the daily check sample automatically.
Command: WAIT hours:minutes:seconds
Other Parameters: <none>
Hours
0-23
Minutes
0-59
Seconds
0-59
For example, WAIT 15:03:56 will wait for 3:03:56
PM, unless this time is already passed, in which
case there will be no wait. Fields can be omitted.
In this case, tailing fields are defaulted to zero, while leading fields are interpreted as
the next matching hour or minute. The following examples illustrate most useful cases:
13:
taken as 13:00:00.
13:10 taken as 13:10:00.
:13
taken as the next occurrence of 13:00 minutes after the hour. At 12:15, this
command would wait for 13:13. At 12:10, this
command would wait for 12:13.
::13 taken as the next occurrence of 13
seconds after the minute


GOTO - This application jumps to
another line of the sample list or
log. Use the following syntax in the
AutoLink field in a Sample List or
Recalc List:
Command: GOTO <line-number>
Other-parameters: Inject or Recalc or Print



WAIT and GOTO can be used to create an infinite
loop to perform an injection every preset time
interval to monitor a process stream.

70. “Verification” run type - reported results compared
to values in a calibration level.

21

71. Access data file actions from Windows Explorer, with
a right-click on .RUN/.XMS files.

72. Automatic data file naming with
tokens.
73. Data file names can
have
up
to
255
characters (NT File
System - contrast to
Virtual File Allocation
Table 8.3).

74. Cannot overwrite data files. - If new data name matches an existing file in the same
folder, then three digits are
automatically appended to the end
the name and incremented
thereafter
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Suggestions for Operations with .XMS data files
75. Peak processing for chromatograms for .XMS files is discussed in Peak Detection
with Varian MS Workstation: http//lotusinstruments.com/wp/wp-content/uploads/
Peak-Detection-with-Varian-MS-Workstation.pdf
76. Suspend and Resume buttons in Active SampleList – During automated operations,
the SampleList can be suspended that will stop activities the end of the current sample.
This allows additional entries to the list, or adjustments to the active method. Then
Resume will continue with the next sample line.

77. Single method for full simultaneous control of both MS and up
to three GC detectors.

78. Active Compounds
Set (ACS) Editor - ACS is a list of
compounds, representing a subset of the
Compound Table, which can be saved in
a method, and activated during
automation.
MSWS
includes
an
interactive application (ACTIV2.EXE) to
create, edit, delete such sets within a
method file. MSWS also includes an
automated application (ACTIVATE.EXE)
which can be invoked within a sample list
to activate one or more sets in the active
method.
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79. Hot Keys in MS Data Review
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80. QML
Commands
(Quadrupole
Macro
Language) – reserved for Scion Service
operations. This is not intended for user
operations.

81. Control Chart
Reports

Target Compound Report for #1 from ...1 minute 07-23-2019 sim.xms

Sample ID:
Instrument ID:
Measurement Type:
Acquisition Date:
Calculation Date:
Sample Type:
Inj. Sample Notes:

82. Compound Reports

10 ppt - 1.67 ppt
Lotus Toxics
Area
7/24/2019 9:48 PM
8/23/2020 9:57 AM
Analysis
None

Operator:
Last Calibration:
Calibration Type:
Data File:
Method:

8/22/2020 7:22 AM
External Standard
...e 07-23-2019 sim.xms
... 7-29-2019\randy.mth

Compound Information
Peak Name:
Result Index:

Propene
1

Compound Number: 1

CAS Number: 115-07-1

Identified

Specification
Highest
14.356 +/- 0.200

Actual

Status

Identification
Parameter
Search Type
Retention Time
Match Result
Qual. Ion Ratio ( 2 ions )

14.362 min.
N/A
19.9% - 59.9%
2.1% - 42.1%

m/z 39.2:39.9%
m/z 42.2:22.1%

Pass
33.6%
25.4%

Pass
Pass

Integration and Quantitation
Parameter
Quan Ions
Calibration Equation
Area
Height
Amount (Conc.)

Specification
41.2+39.2+42.2
Linear, Ignore, 1/nX2
>=500

Actual

Status

y = +1.5401e+5x +7827.7959
234342
27970
1.500 nmol/mol

>= 0 nmol/mol

Pass
Pass

Sample Spectrum for Scan: 16300 RT: 14.362 min.
BP 39 (18277.094=100%) ...- 1.67 ppt inj 1 - master 1 minute
39
18277.094
41
75%
12756.835

Quan ; 41.2+39.2+42.2 ((+) 41.2, 39.2, 42.2)

100%
40

42
8798.809

50%
25%

35

0%
38

30

100%

kCps

75%

39

40

41

42

43

m/z

Reference Spectrum for Propene
Scan: 16282 RT: 14.356 min. ...3 minute 07-23-2019 sim.xms
41
999
39
750
42
649

50%
25
25%
0%
SI

38

EI

20
SS

40

41

42

Raw Sample Spectrum for Scan: 16300 RT: 14.362 min.
BP 39 (18277.094=100%) ...- 1.67 ppt inj 1 - master 1 minute
39
18277.094
41
12756.835

50%

42
8798.809

100%

15

39

75%

ES

43

m/z

25%
0%
13.5

83. Format in View Results - report format
can be altered with options available
through menu from MS Data Review > View
> View Results > Preferences > Results List
Columns. See following list for choices.
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14.0

14.5

15.0

minutes

38

39

40

41

42

43

m/z

Columns to Display
Acquisition Date
Amount
Amount Reject
Amount Units
Amount/RF
Amount/RF Units
Area

Description

The time and date when data file was created.
The calculated result. Amounts are calculated from the calibration curve for all files, including Calibration and Verification files. Areas or heights are reported if
the error conditions that prevent calculation of the result calculated result is not available. N/A is reported for some error conditions that prevent calculation of
the result
Compounds with calculated results less than this are reported as Missing. Applies only to Analytes in Analysis files.
Verification files. Areas or heights are reported if the calculated result is not available. N/A is reported for some error conditions that prevent calculation of the
result,
The
calculated result. Target Compounds report the RF or RRF for Calibration files. Areas or heights are reported if the calculated result is not available. N/A
is reported for some error conditions that prevent calculation of the result.
Units for the Amount/RF results. They are specified in the method for compounds. Unknown peaks that are quantitated with an Internal Standard report the units of
the Internal Standard. When integrated areas or heights are reported for the results, the units are reported as Counts.
The integrated area of the peak. Areas greater than 999999 are reported in scientific notation.

Baseline Code

Two-character codes that specify how peak integration was started, ended, and the type of baseline used. (Select the Results Codes Help menu item for
definitions.)

Calculation Date
Cali. Curve Calculations
Calibration Amount
Calibration Date
Calibration Equation
CAS Number

The time and date when the data file was last quantitated.
The Curve Fit Type, Origin Point, and Regression Weighting used to calculate a calibration curve.
The compound Calibration Level Amount that is specified in the method.
The time and date when a Calibration data file was last processed.
The equation of the calibration curve.
A unique 3-part identification number assigned to a compound by the Chemical Abstracts Service.

Channels

The physical channels on which the scan functions to create the chromatogram were generated. Merged is reported if all available channels are combined.
Merged is always used to quantitate Unknown Peaks.

Coeff. Det.(r2)
Conc./IS Ratio
Data File
Delta RT (min)
Dev%-Amount
Dev%-Curve
Divisor
Error
Expected RT (min)
F. Match
Group Name
Height
In Lib Prob.
Ion Ratios
IS % Dev
IS Amount
IS Area

A measure of how well the calibration points fit the calculated curve.
The Target Compound Amount divided by the Internal Standard Amount that is specified in the method.
The name of the data file.
The difference between the expected compound retention time specified in the method and the actual retention time of the result.
The % Deviation of the Target Compound Amount in a Calibration file, relative to the Calibration Level Amount in the method.
The % Deviation of the Target Compound Amount in a Calibration file, relative to the calibration curve.
A divisor factor specified in the recalc list that is used to calculate Analysis and Verification results. The Divisor can be edited in the Automation Editor.
Single-character result codes that report problems which occurred when the peak was processed. (Select the Results Codes Help menu item for definitions.)
The expected compound retention time that is specified in the method.
A measure of how well a sample spectrum is contained in a library or reference spectrum.
All compounds assigned to a method-specified group are reported as a single summed result in addition to the individual compound results.
The baseline-corrected height of an integrated peak. Heights greater than 999999 are reported in scientific notation.
The probability that the reported match is in the searched library. This applies only to Normal - Forward searches of Unknown Peaks.
The ion ratio specifications and results for the qualifier ions that have been specified for a compound.
The % Deviation of the Internal Standard peak size from the average of the Internal Standard sizes in all of the files.
The nominal amount of the Internal Standard used to quantitate an Analyte as specified in the method.
The integrated area of the Internal Standard peak used to quantitate an Analyte.

IS Factor

A factor used to adjust the Internal Standard Calibration Amount on a per-sample basis. Applies only to Analysis files. The IS Factor can be edited in the
Automation Editor.

IS Height
IS Peak Name
IS RT (min)
Lbr. #
Library
Match Prob.

The baseline-corrected height of the Internal Standard peak used to quantitate an Analyte.
The name of the Internal Standard used to quantitate an Analyte.
The retention time of the Internal Standard peak used to quantitate an Analyte.
The library entry number of the match that was reported from the library search of an Unknown Peak.
The name of the library that contains the match reported from the library search of an Unknown Peak.
The probability that the match reported from the library search of an Unknown Peak is correct, assuming that the correct match is in the database.
The Forward or Reverse Match result used to rank the matches from a search. Target Compound Spectrum Match identification always uses Normal-Forward
searching.
Specifies whether matches from a search are ranked by Forward or Reverse Match results.
A multiplier factor specified in the recalc list that is used to calculate Analysis and Verification results. The Multiplier can be edited in the Automation Editor..
The name of a Target Compound that is specified in the method, or the name of the match that was reported from the library search of an Unknown Peak.
Peaks whose area or height are less than the Peak Reject method specification will be rejected. The Peak integration events will be displayed in the chromatogram,
but Unknown Peak results will not be reported, and Target Compounds will be designated as Missing.
The peak types other than Analyte that may be specified in the method for a Target Compound: SP: Internal Standard, REF: Reference, RRT: Relative
Retention Time.
The 1/2 height peak width that is specified in the method.
The Target Compound peak size divided by the Internal Standard peak size, expressed as %.
The Target Compound peak size divided by the Internal Standard peak size.
The width in seconds at 1/2 height of the integrated peak.
The ions that are specified in the method to create the chromatogram used for quantitation. RIC is specified when all available ions should be used. The ions are
extracted from the ions that are available in the scan functions that are specified for the chromatogram.
A measure of how well a library or reference spectrum is contained in a sample spectrum.
The line number of the reported result.
Compound Result Types are Identified, Missing, or Failed (Failed one or more Ion Ratio specifications). Unknown Peak Result Types are TIC (Tentatively
Identified Compound) Duplicate (maps to a reported Compound result), or Unknown.
The retention time of the integrated peak.
The Response Factor specified in the method to quantitate Unknown Peaks: Nearest IS, Nearest Pure IS, or Absolute.
The Response Factor (External Standard) or Relative Response Factor (Internal Standard) calculated for a Target Compound in a Calibration file.
The retention time of a compound in a data file relative to that of another compound in the data file that has been designated as the RRT Reference in the method.
The Deviation of the RRT result from the RRT of the corresponding method Retention Times. The RRT Tolerance Range, Result, and Status are displayed..
The time window in minutes around the expected compound retention time that will be searched for the Target Compound peak.
The Signal/Noise ratio of the integrated peak. The RMS or Peak-to-Peak Noise Type specified in the method is used.
The Signal/Noise ratio of the integrated peak, relative to a specified threshold. The S/N Threshold, Result, and Status are displayed.
The name of the sample that was specified when the data file was created.
The sample notes that were entered in the Sample List for the data file.
The type of the data file: Calibration, Analysis, or Verification. Baseline data files are not supported by MS quantitation, and are quantitated as Analysis files.
A description of the scan functions from which to create the chromatogram. It is independent of the physical channels that the scan functions are on in a given data
file segment. Merged is reported if all available scan functions are combined. Merged is always used to quantitate Unknown Peaks.
The scan number of the apex point of the integrated peak.
The search type specified in the method to identify the integrated peak. Target Compounds: Spectrum, Nearest, Highest, First, or Last. Unknown Peaks:
Library Search, or None.
A Peak Start is detected when the chromatogram slope exceeds this threshold. The number of points used to calculate the slope is determined by the data
rate and the specified Peak Width.
Single character result codes that report status information or problems which occurred when a peak was processed. Error codes are a subset of the Status codes.
(Select the Results Codes Help menu item for definitions.)
Peaks on the trailing edge of a peak will be integrated as tangent peaks if their heights are less than the specified percent of the parent peak height.
At least one match result must be equal to or greater than this threshold for a Target Compound or an Unknown Peak to be identified.
The top 2 match results that meet the Threshold specification will be reported when an Unknown Peak is library searched.

Match Result
Match Type
Multiplier
Peak Name
Peak Reject
Peak Type
Peak Width Spec.
Peak/IS %
Peak/IS Ratio
Peak Width
Quan Ions
R. Match
Result #
Result Type
Ret Time
RF Used
RF/RRF
RRT
RRT% Deviation
RT. Window
S/n Ratio
S/N Reject
Sample Name
Sample Notes
Sample Type
Scan Descriptor
Scan Number
Search Type
Slope Sensitivity
Status
Tangent %
Threshold
Top 2 Matches
Top 3 Matches
Top Match

The top 3 match results that meet the Threshold specification will be reported when an Unknown Peak is library searched.
The top match result that meets the Threshold specification will be reported when an Unknown Peak is library searched.
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84. Calibration Reports.

85. Edit/Lock Calibration Coefficients –
Some
protocols
required
multiple
standards to set up calibration factors. To
accomplish this, one standard is initially
run to set up its factors. Then those
factors are locked, and the next standard
is run so that the initial coefficients are
maintained. In addition, if response
factors are computed off-line, they can be
entered manually as appropriate.
.

86. Excel Report Templates.
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87. Dash Reporting - report authoring system that provides tools for designing and
generating reports of analytical data from Scion MS Workstation, as well as other
relational database sources. The system works by querying the MS Workstation
database and applying a report method to the data to produce a report, or finished report,
in a wide variety of output layouts. Scion Dash is both an interactive reporting system
(using the Designer) as well as a non-interactive report generation system integrated
within MS Workstation. Using the Designer, report methods can be designed and
previewed interactively, and then stored and used by multiple users in non-interactive
mode. Included in package are instruction videos/
88. Tune Reports – are accessed through an icon on System Control for the Scion SQ Mass
Spectrometer. Common tune molecule is Perfluorotributylamine (FC-43, Scion P/N
392035300). Many EPA GCMS protocols mandate performing specific tune routines to
ensure that NIST library matches are confirmed, including EPA Method TO15, EPA
Method 624.1) and EPA Method 625.1). Common target compounds are 4Fluorobromobenzene (BFB, CAS # 460-00-4, 1 ppmV/V Scion P/N ULSTS110N) and
Decafluorotriphenylphosphine (DFTPP, CAS # 5074-71-5, 2,500 µg/m in methylene
chloride, Restek P/N 31001). Although the requirement is specifically listed in many
standard procedures, NIST has adjusted their search algorithm to minimize the need to
perfectly match the EPA criteria and still achieve appropriate matches.
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89. System Suitability - is a custom report
template used to compute and report
system suitability indicators from Scion MS
Workstation data files. The following types
of reports may be generated:
1. Resolution between selected target
compound peak pairs.
2. Degradation estimates for selected
target
compounds,
where
the
degradation
products
are
also
quantitated as target compounds.
3. Tailing Peak and Gaussian Peak Factors
for selected target compounds (TPF-GPF
Report).
4.
Tune
reports
for
BFB
(bromofluorobenzene)
or
DFTPP
(decafluorotriphenylphosphine) based on EPA method 524, 624, CLPVOL, 8240, or
8260 criteria for BFB or method 525,625, CLPSEM, 8250, or 8270 for DFTPP.

90. Validation of Installed File Systems – is
accessed through MS Workstation >
Validate Installed Files. This action could be
required for many laboratory audits.
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91. EnviroPro Reporting provides
detailed
information on reporting
results for common
USEPA methods - 524,
525, 624.625, 8240,
8250, 8260, 8270, 8270,
CLPVOL and CLPSV.
Tune Reports can be
generated.

92. NIST
Automated
Mass
Spectral
Deconvolution and Identification System
- AMDIS - allows an automation of a
complex process of extracting data
from a GC/MS data file.
AMDIS works by finding
all of the ions that rise
and
fall
at
the
concurrently and then
associating them to a
single component. Once
it
has
found
this
component, it compares it
to a library of spectra and retention indices
provided.

93. NIST 20 (Scion P/N 4121057) and NIST 20 Upgrade
(Scion P/N 4121058) - 350,704 electron ionization
(EI) spectra for 306,643 compounds, 43,774
replicate spectra (39,729 more compounds than
NIST 17) and retention indexes for 139,963
compounds.
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94. Wiley FFNSC Library - Mass Spectra of Flavors and Fragrances of Natural and Synthetic
Compounds, 3rd Edition, 2015 (Scion P/N 394105201) - 3,462 mass spectra, linear
retention index (Kovats index) data, calculated Kovats RI, and searchable chemical
structures of compounds of interest for the flavors and fragrances industry.

95. Pfleger, Maurer, Weber Mass Spectral Library of Drugs, Poisons, Pesticides,
Pollutants, and their Metabolites, 2016 edition (Scion P/N 392052195) - 10,430 spectra
of potentially harmful substances, including 7,800 from metabolites. This reference is
made up of an electronic database accompanied by two hardbound volumes.

96. Rosner Mass Spectra Library of Designer Drug 2019 (Scion P/N 392052102 - is the
largest collection of chemical signatures of new psychoactive substances (NPS) and
drugs of abuse in the world. This impressive mass spectral library was developed to
support forensics and toxicology labs to combat this global health epidemic.

97. Wiley 12th Edition Mass Spectral Library 2020 - Wiley Registry Mass Spectral Library
is the most comprehensive mass spectral library available, making it an essential tool for
general unknown compound identification. Included in the combination package are over
1 million EI mass spectra, over 1 million searchable chemical structures, and over
840,000 unique compounds.

98. Multicompound Software (Scion P/N 393036191) - 19 templates allow various displays
of target compounds, tentatively identified and unknown compounds in 1) graphic and
text, 2) graphics only and 3) text only configurations.

99. mzXMS Conversion Utility - legacy operation; not applicable with .XMS files

100. ToxProPlus MS Reporting Software
(Scion P/N 393036291) - software
includes three separate custom
software packages: multi-compound
software, ion ratio summary report
software, and screening software to aid
reporting.
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101. Summary Report – is only functional with .XMS data
files.

102. Ref Spectrum – is used to identify the
peak can be set either from a standard
spectrum, or from user adjustments of
ions and their intensities.

103. Selected Ions Monitoring (SIM) – Data
from multiple ions can be collected to
provide positive matching to a reference
spectrum with use of multiple characteristic
ions for compounds.
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104. Compound Graph - illustrates scan
times and effects of peak window
overlap with Selected Ions Scanning
(SIS) mode.

105. Expanded view of portion of
Compound Graph - allows
visual indications of overlapping
scan windows. Display area is
selected through mouse actions
on edges of graph or click/drag
inside the presentation. Regions
of overlap degrades the quality
of the data, especially related to
noise levels. In the regions
where these windows coincide,
scan times are divided up and
data points are not collected for
the full time for the target
compound ions.

Propene

39 + 41 + 42

39
41
42

106. Multiple Quan Ions – To boost peak
response, specially for low responders
such as propene and chloromethane,
muliple ions can be defined as scan
functions to enhance peak detection,
especially for SIM mode
33

107. SIM (Selected Ions Monitoring) Peak Confirmation - To confirm identification of a
compound when only selected ions are set in SIM mode, qualifier ions can be set up with
ion ratios to the base peak. A match is labeled as “ID” in the final report. Obviously NIST
library searches do not apply.

108. Convert .XMS files to Content Definition File - .CDF - is a file format from ANSI (American
National Standards Institute) allows a .XMS file to be opened in other chromatography systems.
The files created in this format are saved with the .CDF file suffix in an XML-based data format.

109. Convert files to AIA (Analytical
Instruments Association)2 ASTM E1947 - 98(2014)
Standard Specification for Analytical
Data
Interchange
Protocol
for
Chromatographic Data. This app
generates .CDF files that can be
exported/imported into other brands of
chromatography software compatible
with AIA format.
2

D.C. Nelson, Chemometrics and Intelligent Laboratory Systems, 26 (1994), p. 43.
www.sciencedirect.com/science/ article/abs/pii/0169743994900175

34

110. Export to NetCDF (Network Common Data Form) is a set of software libraries and
machine-independent data formats that support the creation, access, and sharing of
array-oriented scientific data. It is also a community standard for sharing scientific data.
The Unidata Program Center supports and maintains netCDF programming interfaces for
C, C++, Java, and Fortran. Programming interfaces are also available for Python, IDL,
MATLAB, R, Ruby, and Perl.

111. .XMS data files for MS possess:
 Raw data points
 Last computed results
 Copy of last method used
 Link to original method
 Complete calibration data
 Response Factors
 Calibration Point Information
 Calibration Amounts
 Calibration Peak Sizes
 Deviations from Curve
 Replicates
 Link to Calibration .XMS data file
 Calibration Levels (up to 50)
 Coefficients
 Curve Fit Factors
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Hints with Operations with GC Detector .RUN Data Files
112. Peak processing for chromatograms for GC detector run files - are discussed in Peak
Detection with Varian Star Workstation. http://lotusinstruments.com/wp/wpcontent/uploads/Peak-Detection-with-Varian-Star-Workstation.pdf

113. Display of peak details in Interactive
Graphics. Highlight desired peak and carefully
drop straight down to expose other peak
information.

114. Insert .RUN data file into MS Data
Review from Windows Explorer by
right-clicking on desired data file.

115. ASCII conversion of raw .RUN data points
through MS Data Review - right-click on
chromatogram.
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116. .RUN file inserted into MS Data
Review has limited operations and
is intended primarily to directly
comparing GC detector responses
to a MS chromatogram. One action
available is Integrate Area.

2
slope = -0.0235 mV

Millivolts

1
0

117. Detector signal drift - computed
through Trend Line of ASCII data
points via Excel.

y = -0.0235x + 0.0982

-1
-2
0

1

2

3

Time (minutes)

4

5

118. Change background colors of displayed live
chromatograms.
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119. Display of live chromatograms
in System Control - single, double or
triple, and horizontal or vertical.

120. Change Run Time in Active Chromatogram
- Keyboard on Scion 436/456
is active during a run, and the
column oven hold time in the
final step can be adjusted
longer or shorter time to impact
both the GC run time and GC
detector(s) data collection end
time. This change does not
alter the Scion SQ run time.

121. Hide Keypad – to set chromatogram
display for full screen.
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5.806

3.821

mVolts

5.310

122. Add/remove extra notations
on displayed chromatogram in
Interactive Graphics.

600

123. To display a chromatogram in
external documents, such as Word,
“copy” from Interactive Graphics to
Clipboard and then “paste” into the
Word.docx. This action allows the
chromatogram labels to be edited and
comments added.

500

3.361

400

300

200

100

0

-68
2.5

5.0

7.5

10.0

12.5

15.0

17.5
Minutes

124. Interactive Graphic display of
retention time to 0.0001 minutes.
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125. Detector frequency - This parameter impacts data collection with number of data points
used to define the peak combined with monitored noise level.

126. Single method possesses:
 Full set of parameters for control of GC
 Full set of parameters for computation of results
 Complete calibration data
 Raw data points
 Last computed results
 Copy of last method used
 Link to original method
 Complete calibration data
 Response Factors
 Calibration Point Information
 Calibration Amounts
 Calibration Peak Sizes
 Deviations from Curve
 Replicates
 Link to Calibration .XMS data file
 Calibration Levels (up to 50)
 Coefficients
 Curve Fit Factors
 Formatting for chromatograms and reports
 Baseline subtract data points
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127. RUN data file for GC detectors possesses:
 Raw data points
 Instrument run log
 Last computed results
 Copy of data handling sections from last method used
 Link to original method
 Baseline subtract data points
 Complete calibration data
 Raw data points
 Last computed results
 Copy of last method used
 Link to original method
 Complete calibration data
 Response Factors
 Calibration Point Information
 Calibration Amounts
 Calibration Peak Sizes
 Deviations from Curve
 Replicates
 Link to Calibration .XMS data file
 Calibration Levels (up to 50)
 Coefficients
 Curve Fit Factors

128. Display of data points - provides visualization of proper definition of peak shape. Data
interval is set by detector frequency and expected peak width. Optimum settings should
yeild 10 data points across top of peak.

mVolts

3

0
6.300

6.350

6.400

Minutes

6.450
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129. Open Original Method - .RUN files possess
a link to the original method used to collect
the data.

130. Build Method from Datafile – In Interactive
Graphics, data handling section last used to
compute results can be recovered for the displayed
.RUN chromatogram.

131. Fill Peak Table - is accessible
through
Interactive
Graphics.
Clicking on peaks in the displayed
chromatogram will add these peaks
to Peak Table of active method.
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132. Graphically relocate retention times in Peak
Table - by right-clicking on yellow window under
peak and move to adjust.

133. Adjustment of retention time by
Reference Peaks (peak windows in
blue). Update only occurs when
“calibration” is performed.

134. Add peak table entry- by rightclicking in window below the
chromatogram.

135. Add timed events - by rightclicking in window below the
chromatogram.
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136. Graphically relocate time events with mouse.

137. Reporting and Printing of Results:



Set up for automated printing - at run
end with Automated Printing enabled.
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Chose printing parameters in
method. Printouts on injection can
be suppressed to prevent operations
to be locked up if printer jams.

138. Replicate Treatment in Method
Builder - Preset value is set to
Average Calibration Replicates.
Often the individual data points
are desired to be indicated
separately and this parameter can
be changed to “Keep Replicates
Separate”.

139. Replicate Tolerance in Method Builder Preset value is set to add replicates within a tight
tolerance of 0.5%. Better choice is either to
widen the tolerance or “Always add new
replicates”.

140. Baseline Subtraction - The baseline
run is a reduced set of 257 to 512 data
points across the chromatogram run
time by a bunching process, is stored
within the method used for its
collection and is subsequently
subtracted from sample runs prior to
peak detection. Baseline Subtraction
is activated by enabling it in Method
Builder > Integration Parameters >
Subtract Blank Baseline, and by
indicating the first run in a series in
SampleList as Sample Type –
“Baseline”.
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141. Grouping by time interval – detector
response can be grouped over a userselectable time interval. This process is
often used for grouping non-methane
hydrocarbons in EPA Method 25, and for
summing up all hydrocarbons in natural
gas for Hexane+. Assigned retention time
for the group is the midpoint between and
starting and ending points. Sep Code in
report is labeled as “GR”.

142. Grouping by peak label –
After computations are
perfomed
for
peak
concentrations, selected
peaks can be grouped by
peak name. Examples
include
summing
up
separate
peaks
in
measurement
of
polychlorinated biphenyls,
toxaphenes, and aromatic
hydrocarbons.
Bruker MS Workstation

143. Natural gas calculations - reports values for mol%, BTU,
specific gravity, gallons per thousand, and compressibility.3

Available from Lotus Consulting.

Natural Gas
Analysis Report
Run File
Method

CCVNGE1205 20190422 091635.RUN
nge 041819.mth

Operator
Meter Number
Effective Date
Received Date

Analysis Date
Company
Pulled Data
Composite/Spot

65241
4/20/2019

Mole %
0.000
2.999
80.152
6.024
5.971
2.514
0.653
0.654
0.353
0.354
0.227
0.055

Component
H2S
Nitrogen
Methane
Carbon Dioxide
Ethane
Propane
I-Butane
N-Butane
I-Pentane
N-Pentane
Hexanes
Heptanes
Octanes

4/22/2019
4/18/2019

GPM
0.0000
0.3308
13.6252
1.0309
1.6012
0.6944
0.2142
0.2067
0.1294
0.1286
0.0934
0.0255

0.030

0.0155

0.015
0.000
0.000
100.000

0.0085
0.0000
0.0000
18.1043

Major Laboratories
Nonanes+
Decanes
Undecanes

2345 Main Street
Long Beach, California

Totals
Relative Density from Composition

222/652-6911
PCB PATTERN MATCHING ANALYSIS REPORT
SAMPLE

Injection Date:08/03/99 17:27

Activity:Quarterly Check Sample
Sample Type:Transformer Oil

Module:44

Instrument

Run Filename:Lab #27617 8-3-99

Weight:12.60

GC E

4/22/19 8:18 AM

Report Date:08/04/99 9:25

STANDARD NAME

INJ. DATE

OUTCOME

CONC.

%RSD

PCB1026

08/03/99 10:19

< Standard

0.0

PCB1221

08/03/99 10:50

< Standard

0.0

PCB1232

08/03/99 11:22

< Standard

PCB1242

08/03/99 11:54

< Standard

PCB1248

08/03/99 12:24

Failed RSD

0.0

PCB1254

08/03/99 12:55

Confirmed

97.9

3.9%

PCB1260

08/03/99 13:24

Failed RSD

0.0

170.9%

PCB1262

08/03/99 13:54

Failed RSD

0.0

169.5%

PCB1268

08/03/99 14:54

Failed RSD

0.0

128.9%

0.0
0.0
156.2%

“TOTAL PCB CONCENTRATION FOR LAB #27617 IS 97.9 mg/kg”
“WARNING – TOTAL PCB CONCENTRATION EXCEEDS 50 PPM!”

Matching Parameters:
Number of Standards

9

Minimum Peaks for Valid Match

20

Percent of Standard Required

70%

Retention Time Tolerance Width

0.04min.

Retention Time Tolerance Percent

0.30%

RSD Tolerance

40.00%

144. Pattern Matching for Polychlorinated Biphenyls (PCBs) available from Lotus Consulting. User selects standards and
application compares them to unknowns and reports back
matches, and compositions of mixtures.

40%
Approved by:___________________

3

94.89
4.84
99.73

Channel:Front = ECD

Volume:10.00

Portion of Mixture Required

60.46

TCD2B:
FID1A:
Total:

Instrument:PCB Analyzer #6

Collection Date:08/01/99

0.99703

Compressibility
C6+ Predicted Cricondentherm HCDP (o F):

Operator:R B-COOK

Reception Date:08/03/99

1,053
1,072

BTUs @ 14.73 Saturated
BTUs @ 14.73 Dry

Extraction Date:08/03/99

Source:Transformer 42314

0.7209

Lab Density Test Value

ANALYSIS

Sample Name:Lab #27617

Date:______

Gas Processor Association, 6525 East 60th Street, Tulsa, Oklahoma 74145,
http://ihsmarkit.com/products/gpa-standards.html
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145. Master/Slave
Gas
Chromatographs
Some
applications require more hardware capabilities than are
available in one instrument. By combining two gas
chromatographs in a Master/Slave configuration,
accessible resources are doubled. One gas sample is
loaded into both instruments, and the master then starts
both concurrently. A single method loads parameters for
both chromatographs. The configuration allows a single
method to fully control two separate temperatureprogrammable column ovens, six GC detectors and a
mass spectrometer, 12 electronic flow controllers, 6
detector flow controllers, two 8400 AutoSamplers (up to
200 liquid sample vials), and up to 32 external events.
Typical examples are full speciation of hydrocarbons in
vehicle exhaust (http://lotusinstruments.com/wp/wpcontent/uploads/Quantitation-of-Hydrocarbons-inVehicle-Exhaust-and-Ambient-Air.pdf) and measurement of
trace impurities in hydrogen fuel (http://lotusinstruments.
com/applications/hydrogenfuel/#hfa).
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Index
.Run file inserted into MS Data Review
“Verification” run type
Access any method even when active on GC
Access data file actions from Windows Explorer
Activate “Last Edited” method.
Activate method through SampleList.
Active Compounds Set (ACS) Editor
Add peak table entry
Add timed events
Add/remove extra notations
Adjustment of retention time by Reference Peaks
Approaches to opening method
ASCII conversion of raw .RUN data points through MS Data Review
Automatic data file naming with tokens.
Automatic recalculation of data files with Sequence list with different method
Automatic update of method
Baseline Subtraction
Batch Processing
Build Method from Datafile
Calculation of Retention Time
Calibration plots of response factor versus log[concentration]
Calibration Reports
Cannot overwrite data files
Change background colors
Change rtime/value
Change Run Time in Active Chromatogram
Compound Graph
Compound Reports
Compute GC Detector Peak to Peak Noise in MS Data Review.
Compute GC Detector Root Mean Square Noise
Concurrent data collection
Concurrent instrument control and data collection
Control Chart Reports
Convert .XMS files to Content Definition File - .CDF
Convert files to AIA (Analytical Instruments Association)
Copy/paste lines in RecalcList
Copy/paste lines in SampleList
Dash Reporting
Data file names can have up to 255 characters.
Data Rates for GC Detectors
Detector frequency
Detector signal drift
Direct access to Inject Single Sample
Direct access to SampleList from 8400 display
Display of data points
Display of live chromatograms in System Control
Display of peak details in Interactive Graphics.
Drag/drop data files into Recalc list.
Echo
Edit out obviously invalid data points
Edit/Lock Calibration Coefficients
Edit/Lock Coefficients
Enable Automated Printing
Entry and display of temperature zones in 0.1 oC increments.
EnviroPro Reporting
Excel Report Templates
Expanded view of portion of Compound Graph
Export SampleList to Excel
Export to NetCDF
FID/NPD/PDD Detector Full Scale
Fill Peak Table
Format in View Results
Full access to methods through instrument display
GC chromatogram can be displayed in MS Data Review
GC Remote Control
Graphic display of calibration plot
Graphic display of calibration plot for MS data
Graphically relocate retention times in Peak Table
Graphically relocate time events
Grouping by peak label
Grouping by time interval
Header block in System Control
Hide Keypad

116
70
8
71
53
52
78
134
135
122
133
50
115
72
35
9
140
32
130
26
22
84
74
118
5
120
104
82
19
20
17
16
81
108
109
61
60
87
73
14
125
117
42
41
128
119
113
25
37
46
85
49
66
12
91
86
105
57
110
11
131
83
2
18
3
44
45
132
136
142
141
38
121

Hot Keys in MS Data Review
Import SampleList from Excel.
Indication that Method file has not been saved
Insert .RUN data file into MS Data Review
Instrument Log
Interactive Graphic display of retention time
Interconversion of detector response and concentration
Live display of all valve activities
Master/Slave Gas Chromatographs
MessageLog
Move columns in SampleList
Multicompound Software
Multiple Quan Ions
mzXMS Conversion Utility
Name of Operator can be entered
Natural gas calculations
NIST 20 (Scion P/N 4121057) and NIST 20 Upgrade
NIST Automated Mass Spectral Deconvolution and Identification System - AMDIS
Notes
Open Original Method
Pattern Matching for Polychlorinated Biphenyls
Peak processing for chromatograms for .XMS files
Peak processing for chromatograms for GC detector run files
Peak Width at ½ height reported in seconds
Pfleger, Maurer, Weber Mass Spectral Library of Drugs, Poisons, Pesticides, Pollutants
QML Commands
Ready “Green”/Not Ready “Red” status lights.
Reboot gas chromatographs
Recalc List
Recent Files button
Ref Spectrum
Relabel column header
Replicate Tolerance in Method Builder
Replicate Treatment in Method Builder
Reporting and Printing of Results
Response factors computed as ,
Resume Plot
Retention Time reported in 0.001 minute increments
Rosner Mass Spectra Library of Designer Drug
Run Counter
RUN data file for GC detectors possesses
Runlog
Sample injection time/date and sample name are locked
SampleList AutoLink commands:
Security
Selected Ions Monitoring (SIM)
Sep Codes
Sequence List
Set Generic Entries
SIM Peak Confirmation
Single method for full simultaneous control of both MS and up to three GC detectors.
Single method possesses
Source of calibration data point
Specify/Create data file folder from SampleList.
Stability of temperature zones
Start and end points for peak integration
Status/Error Codes
Stream Selector Valve Controller
Summary Report
Suspend and Resume buttons in Active SampleList
System Control should be closed before powering off the GC,
System Suitability
Tangent Percent for fused peaks
To display a chromatogram in external documents
ToxProPlus MS Reporting Software
Tune Reports
Up to 50 calibration levels
Validation of Installed File Systems
View multiple methods side-by-side
Wiley 12th Edition Mass Spectral Library 2020
Wiley FFNSC Library
XMS data files

79
58
51
114
6
124
47
39
145
36
62
98
106
99
34
143
93
92
31
129
144
75
112
28
95
80
15
4
24
65
102
63
139
138
137
23
10
27
96
43
127
7
33
69
64
103
55
30
59
107
77
126
48
67
13
29
68
40
101
76
1
89
56
123
100
88
21
90
54
97
94
111
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